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1. Introduction 
 

This manual serves as an installation and user guide for the StAnD Meteor Camera Kit, 
developed to automatically detect bright meteors (otherwise known as fireballs and/or 
bolides) during night-time, if weather conditions are favorable.  

The camera module used in the StAnD Meteor Camera Kit is all-sky, i.e. it is able to image 
the whole observable sky (down to ~10° above the local horizon) in only one acquisition. 

This module is operated at 30 frames per second (fps) during night-time by the mini-PC that 
is provided in the kit. Data of meteor observations are automatically saved when the system 
recognizes the occurrence of a bright source moving in the Field of View (FoV) of the camera.  

The data, configuration and control of the StAnD Meteor Camera Kit are accessible through 
standard SSH (Secure Shell Protocol) or a browser interface, either locally or remotely. The 
data acquired by the StAnD cameras are also shared among all the project participants on a 
cloud service, to enable the triangulation of the meteors observed by more than one station 
of the network and to allow teachers and students from other schools to join the StAnD 
project, even if they do not have access to a camera by themselves. 

Finally, the data acquired by the StAnD Meteor Camera Kit can be analyzed through the Data 
Analysis Tool (PWwidget) provided with the kit. This tool enables visualizing and exporting 
animation or timelapse of the data acquired by the camera and their scientific analysis, with 
the final objectives of unveiling the origin of the observed object within the Solar System 
and understanding if a fragment of it, i.e. a meteorite, has survived the atmospheric flight 
and fell to the ground. 

The idea of StAnD originated from the experience of PRISMA (Prima Rete Italiana per la 
Sorveglianza sistematica di Meteore ed Atmosfera, i.e. First Italian Network for the 
systematic Surveillance of Meteors and the Atmosphere), a professional fireball network in 
Italy run by INAF, the Italian National Institute for Astrophysics. PRISMA is part of FRIPON 
(Fireball Recovery and InterPlanetary Observation Network), an international collaboration 
that involves many national meteor and fireball networks around Europe and worldwide. 
 

 

Figure 1 – The first all-sky camera of the PRISMA network in Italy, installed in 2016 on the roof of the office 
building of the Astrophysical Observatory of Torino, part of INAF - the National Institute of Astrophysics.  
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The following sections of this introduction provide a short summary covering the topics of 
meteoroids, meteors and meteorites and the methods to observe meteors, with a focus on 
the optical ones. For a complete overview about these topics, please refer to the StAnD 
Teacher’s Manual. 

1.1. Meteoroids, Meteors and Meteorites 

Apart from our central star (the Sun), the eight major planets, and their satellites (like the 
Moon) the Solar System is populated by a vast class of minor bodies (see Teacher’s Manual, 
Chapter 3 and 4). Such bodies are usually classified according to their size: 

●​ Predominantly round and large-sized objects orbiting around the Sun are called dwarf 
planets. This is the case of 1 Ceres, known as the first discovered asteroid and that 
has a diameter of about 940 km. 

●​ Irregularly shaped rocky bodies orbiting around the Sun (that are neither planets nor 
dwarf planets) are called asteroids. A famous asteroid today is 101955 Bennu, a 
“small” 480 m asteroid that was visited by the NASA sample-return mission 
OSIRIS-REx. 

●​ Minor objects like asteroids but made of more fragile material, like ice and dust, are 
called comets. They are the most famous objects because they exhibit a tail of dust 
particles when approaching the vicinity of the Sun, sometimes visible from the Earth. 

●​ Objects that qualify as asteroids or comets but that are smaller than 1 m are called 
meteoroids. These objects are so small that ground-based telescopes cannot 
systematically observe them, but only if they are very close to the Earth. Meteoroids 
are usually fragments of asteroids (or particles ejected from comets) that were 
ejected from the parent asteroid after a collision with another object. Similarly, 
meteoroids can also originate from major planets. 

 ​

       

Figure 2 – The 3D models of 1 Ceres (left panel) and 101955 Bennu (right panel) coming from direct 
observation of these asteroids. Small asteroids and meteoroids can have very irregular shapes. They usually 
rotate on themselves at fast rates (1 turn every 4.3 hours in the case of Bennu). The effect of such fast 
rotation often leads to top-shaped asteroids (like Bennu). Credits:  NASA Visualization Technology Applications 
and Development (VTAD) - link 
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Figure 3 – The first direct imaging of the comet 1P/Halley, taken in 1986 by the European spacecraft Giotto. 
As a scale for the image, the nucleus has an average diameter of ∼11 km. Credits: Halley Multicolor Camera 
Team, Giotto Project, ESA - link​
 
Minor bodies orbit around the Sun on more (comets) or less (asteroid) eccentric orbits. Most 
of the population of asteroids and meteoroids orbits within the Main Belt of Asteroids, 
between Mars and Jupiter. If their orbit is close to the one of the Earth, they are called 
Near-Earth Objects (NEOs, see Teacher’s Manual, Chapter 5.1).  

For such objects, it can happen that they approach the Earth’s position and deviate from 
their original orbit, pulled by the Earth’s gravitational attraction. In this case, the interaction 
between the meteoroid and the Earth’s atmosphere originates a phenomenon called 
meteor. In specific terms, a meteor is "[...] the light and associated physical phenomena 
(heat, shock, ionization), which results from the high-speed entry of a solid object from space 
into a gaseous atmosphere", as of the definition of the International Astronomical Union. 
The most evident feature of a meteor is its light emission, originating from the heating of the 
meteoroid material and of the surrounding atmosphere mostly due to the high friction 
caused by the supersonic atmospheric entry. Indeed, meteoroids from the Solar System can 
impact the Earth’s atmosphere with a speed between 11 and 72 km/s, that is from 35 to 240 
times the speed of sound in air at standard temperature and pressure (see Teacher’s 
Manual, Chapter 5.2).  

Meteors can have either an asteroidal or cometary origin. Since asteroids usually orbit 
around the Sun with a prograde orbit (i.e. counterclockwise looked from above the Sun, as 
all the major planets do), asteroidal meteors usually have a slower impact speed (11 - 40 
km/s). On the contrary, since comets usually have a retrograde orbit (i.e. clockwise), 
cometary meteors usually impact the Earth’s atmosphere at higher speed (40 - 72 km/s). 
Cometary meteors usually originate from meteoroid streams, produced by comets that 
release particles along their orbit due to the effect of the solar wind, and producing meteor 
showers when the Earth crosses the orbit of the comet (see Teacher’s Manual, Chapter 5.3).  
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Further terminology is used in meteor science. A meteor that shines brighter than Venus (the 
second brightest object in the night sky) is called a fireball. It can also happen that the 
meteoroid fragments in different pieces during its atmospheric flight, due to the very high 
pressure that originates from the hypersonic flight. These fragmentation events usually 
correspond to bright flashes (flares) of the fireball, which are called bolides when such 
events occur. Such flares release in the atmosphere a large quantity of meteoritic dust that 
slowly deposits downwards to the Earth’s surface. Such μm- to mm- sized particles can be 
recovered on the ground and are called micrometeorites. They can originate also from very 
microscopic meteoroids (< 30 μm in size) that are also called Interplanetary Dust Particles 
(IDPs), which do not ignite as meteors when impacting the Earth’s atmosphere 

On rare occasions, in about 0.1% of the cases of fireballs occurring on Earth, a small residue 
of the meteoroid survives the atmospheric flight. The bright, visible phase of the meteor 
ends at about 20-30 km of altitude from the ground, and the surviving fragments eventually 
fall to the ground after the so-called dark flight. These stones are called meteorites. The 
recovery of meteorites and the analysis of their composition is fundamental to understand 
the formation and evolution of minor and major bodies, since they preserve pristine samples 
from the early stages of the Solar System. 
 

 

Figure 4 – The first photograph of a meteor, taken on 27th November 1885 by the astronomer Ladislaus 
Weinek in Prague. Credits: AMS - link 

1.2. Observational Methods 

The first scientific observation of a meteor dates back 140 years (see Figure 4) and, since 
then, systematic or sporadic observations of meteors have been carried out by both the 
professional and amateur community of astronomers. To date, meteor observations are the 
only way to probe the population of small-sized asteroids and meteoroids. Indeed, the 
smallest asteroid ever detected by a direct, ground-based telescopic observation is 2015 
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TC25, with an estimated size of 2 m, but this observation was possible only thanks to its 
unusually high albedo (i.e. the fraction of Sunlight that the asteroid surface is able to reflect) 
of about 60%. Current estimations suggest that we observed >90% of the NEO population 
above 1 km in size. On the other hand, the population of small asteroids below 100 m is 
poorly constrained. 

The most fruitful method to observe meteors is by optical observation, that is detecting the 
light emitted by the meteor with a telescope or a camera. Wide-field telescopes, and 
especially all-sky cameras, are preferable in this case in order to cover the highest portion of 
the observable sky and maximize the detection efficiency of meteors, since meteors not 
originating from known comets are sporadic events (i.e. the observer does not know, a priori, 
when and where in the sky a meteor will occur).  

All-sky cameras are typically built using commercially available camera modules equipped 
with a fish-eye objective, able to capture the whole visible hemisphere. Such a result can be 
obtained by distorting the FoV into the focal plane of the camera in a circular image, for 
which the outer circumference is the local horizon. 
 

     

Figure 5 – The functioning principle of all-sky cameras equipped with a fish-eye objective. A composite optic 
system (left panel) focuses the light incident onto the outer lens towards the focal plane, introducing 
significant distortion. The resulting image acquired by the camera is circular (right panel). Light rays coming 
from the horizon are focused towards the outer border of the image (red circle), while the ones coming from 
the zenith direction are directed towards the centre of the image. Credits: (left) Frogget, B. C. et al, “A fisheye 
lens as a photonic Doppler velocimetry probe”, Proceedings of SPIE, 2012 - link, (right) Avaruussӓӓkeskus, 
RWC Finland - link 
 
Optical observations of meteors are carried out in two possible ways: 

●​ Photographic observations: the objective is left open to incoming light for a certain 
amount of time (a few minutes to the whole night, depending on the sensitivity of 
the instrument). During the night, stars apparently rotate around the North Pole and 
appear as circular star trails, while meteors and fireballs produce slanting straight 
and bright strikes with respect to the background of star trails. To obtain a relative 
indication of the time, such devices are usually equipped with a rotating shutter that 
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periodically obscures the objective, leaving equally spaced dark ticks along star trails 
and meteor strikes. 

●​ Video observations: the camera performs short and consecutive acquisitions, being 
operated at high frame rates (30 - 60 fps) and capturing the image and motion of the 
meteor at each instant, with an absolute time reference. Due to the short exposure 
times, video observations are mostly used for the detection of fireballs and bolides. 
On the contrary, high-sensitivity professional cameras must be used to capture faint 
meteors by video observations. 

 

 

Figure 6 – Photograph of a fireball detected on 21 January 1999 by the Czech station No. 16 of the European 
Fireball Network camera system. Star trails are visible as circular arcs centred on the North Pole. The bright 
fireball crosses the star trails almost perpendicularly. Credits: ISSI Bern - link 
 

Observations of meteors can be carried out on other channels as well. For example: 

●​ Radio: detecting radio waves (from military or communication infrastructures) 
reflected by the plasma channel generated by the meteor. 

●​ Acoustic: detecting the shock waves generated by the hypersonic motion of the 
meteor, either in air (by infrasound detectors) or when they impact the Earth’s 
surface (by seismic stations). 

●​ Spectroscopy: the intensity of the light emitted by the meteor at different 
wavelengths can unveil the meteoroid composition. 
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Figure 7 – The StAnD Meteor Camera Kit installed and displayed in the lecture room of the first StAnD 
Summer School on 30 June - 05 July in Marathons, Greece. In this case, the camera module is installed on a 
wooden support just to display the kit indoors. Since no Ethernet wall plug was available in the room, the kit 
network is connected to the Internet through the Ethernet plug of a laptop, which operates as a router and 
from which one can access the system interface directly. 

2. StAnD Meteor Camera Kit 
 
The StAnD Meteor Camera Kit is designed to autonomously monitor the night sky in order to 
detect fireballs and bolides. The kit consists of three main components: 

1.​ The control mini-PC: it controls the whole system through an open-source program 
named FreeTure, a Free software to capTure meteors. This program operates the 
camera, handles the data acquisition schedule during day and night and, most 
importantly, it runs the trigger for meteor data (the video stream acquired during 
night-time at 30 fps) to recognize the passage of a fireball in the FoV of the camera. A 
trigger is an algorithm that automatically checks for the occurrence of particular 
events in some data. In this case, the algorithm checks for bright sources moving on 
a straight line with a high angular speed, compatible with the speed range of 
meteors in the Earth’s atmosphere (11 - 72 km/s, see Section 1.1). In such a case, 
FreeTure saves a portion of the video stream (a few seconds before and after the 
fireball detection) and marks this occurrence as a detection (i.e. the data of a fireball 
captured by one camera). It is connected to the other components and to the 
Internet through an Ethernet cable going to the network switch. 

2.​ The all-sky camera: a PoE (Power over Ethernet) camera module coupled with a 
fish-eye objective, enclosed in a passive-cooling case and exposed through a plastic 
dome to protect the camera and optics. In its operative configuration, the camera is 
installed on the roof / balcony of the building, through its mounting system. The 
camera is connected to the whole system through a 5-m Ethernet cable (attached to 
the case with a waterproof extender) through the network switch, which also 
provides power to the camera. 

3.​ The network switch: a network hub that connects the whole system locally, providing 
power to the camera and Internet to the mini-PC. It is connected to the Internet 
through an Ethernet cable going to the wall Ethernet plug, or directly to the router. 
The data acquired by the kit are then handled by the INAF - PRISMA servers. 
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Both the mini-PC and the network switch are connected through their own power supply 
adapter to a wall power outlet, while the all-sky camera is powered through the switch by 
PoE. The connection scheme is presented below. 
 

 

Figure 7 – Schematic representation of the StAnD Meteor Camera Kit. The light violet box encloses 
components installed indoors, while components in the light blue box are installed outdoors (only the all-sky 
camera). Ethernet cables are represented as single solid black lines and power cables as double solid black 
lines. The system is connected to the Internet through the network switch, and data are synced and ingested 
by the servers of the PRISMA fireball network (hosted at INAF - Osservatorio Astronomico di Trieste). 

2.1. Hardware Description 

The kit is assembled and shipped by N-3 srl. 

A. All-sky Camera 

The all-sky camera consists of several parts: 

●​ The protective case and dome, produced by 
Shelyak instruments (Figure 8, left panel); 

●​ The camera module - Lucid Visions Phoenix 3.2 
MP (model PHX032S-MS), equipping a Sony 
IMX265 CMOS sensor (Figure 8, central panel); 
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●​ The fish-eye lens, model BQ1550B-12MP, with 1.55mm focal length F2.8 (Figure 8, 
right panel). 

 

     

Figure 8 – The main components of the all-sky camera included in the StAnD Meteor Camera Kit. From left to 
right: the protective case and plastic dome from Shelyak Instruments, the camera module Lucid Visions 
Phoenix 3.2 MP and the fish-eye lens. 

B. Mounting System of the All-Sky Camera 

The camera is provided with a mounting system made of stainless steel parts, which allows it 
to be mounted on a level or inclined surface, on a wall, or a pole, depending on the 
configuration of the installation site. It is made of: 

●​ A main body (a stainless steel flange, see Figure 
9, top left panel) over which the bottom of the 
camera is screwed; 

●​ Two side panels (two stainless steel parts, see 
Figure 9, top central panel) that support the main 
body; 

●​ A pole mounting plate (see Figure 9, top right 
panel) to be inserted under the two side panels if 
the camera has to be mounted on a pole (not 
recommended). 

The system is complemented by the needed screws, two pole mounting rivets, a junction 
box, and an ethernet RJ4 coupler (see Fig. 10). 
 

   

Figure 9 – 3D rendering of the main components of the mounting system for the all-sky camera. From left to 
right: the main body (B1), two side panels (B2) and the pole mounting plate (B3). Credits: FRIPON - link 
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Figure 10 – Pictures of the accessory components of the mounting system for the all-sky camera. From left to 
right: bolts, nuts and rings to fix the camera support (M4 bolts - small ones, B4a) and the pole mounting 
support (M5 bolts - big ones, B4b), two pole mounting rivets (B5), junction box (B6), and a female-to-female 
Ethernet RJ4 coupler. 

C. Control mini-PC 

The mini-PC included in the Meteor Camera Kit has the following specifics: 

DELL OptiPlex Micro Form Factor​
(producer code 08XD1, EAN:5397184800867) 

●​ Processor Intel i5-13500T 

●​ 8 GB RAM 

●​ Storage 256 GB SSD, custom upgraded to 1 TB SSD before shipping (KINGSTON NV2 
SSD 1 TB M.2 NVME 2280 PCIE 4.0) 

●​ Operating Systems: Windows 11 Pro (from factory), Debian GNU/Linux 11 (installed 
before shipping) 

●​ 1 year warranty 

The mini-PC is pictured in Figure 11. It comes with its own power supply adapter, which 
specifics are highlighted in the figure to avoid confusion while installing the kit. Figure 12 
illustrates all the ports on the front and back of the mini-PC. 
 

     

Figure 11 – Pictures of the Mini-PC provided in the StAnD Meteor Camera Kit. From left to right: the Mini-PC 
in display mode (C), its power supply adapter (C1) and the specifics of the power adapter. 
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Figure 12 – Pictures of the front (top panel) and back portion (bottom panel) of the Mini-PC with ports and 
buttons highlighted. 

D. Network Switch 

The network switch included in the Meteor Camera Kit has the following specifics: 

DLINK - Smart Switch Gigabit 10P GIGABIT 8 ports PoE + 2 Mini-GBIC ​
(producer code DGS-1210-10P, EAN:0790069467721) 

●​ 8 ports 1000Base-T 802.3af/802.3at PoE 

●​ 2 SFP ports 

●​ 65 W PoE Budget 

●​ Fanless 

The switch is pictured in Figure 13. It comes with its own power supply adapter, which 
specifics are highlighted in the figure to avoid confusion while installing the kit. Figure 14 
illustrates all the ports on the front and back of the switch. 
 

     
Figure 13 – Pictures of the network switch provided in the StAnD Meteor Camera Kit. From left to right: the 
network switch in display mode (D), its power supply adapter (D1) and the specifics of the power adapter. 
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Figure 14 – Pictures of the front (top panel) and back portion (bottom panel) of the network switch with 
ports highlighted. The red box highlights the LED panel, with one LED for each Ethernet port (1 - 8). Each LED 
will flash a steady green light if the corresponding port is currently connected to a device via an Ethernet 
cable. Ports 9 and 10 are SFP ports and will not be used in the current configuration. 

E. Ethernet Cables 

The Ethernet cables to connect the all-sky camera, mini-PC and network switch are provided 
in the Meteor Camera Kit. They are shown in Figure 15. In particular: 

●​ 2 m Ethernet cable Cat5e to connect the mini-PC to the network switch (E1); 

●​ 5 m Ethernet cable Cat6 (LZSH fireproof) to connect the all-sky camera to the 
network switch (E2); 

●​ A waterproof RJ4 Ethernet coupler (E3) to join the 5 m Ethernet cable to the short 
one embedded in the case of the all-sky camera. 

The detailed scheme of the connections is highlighted in Figure 7. An additional Ethernet 
cable is needed to connect the network switch to the Ethernet wall plug (not included in 
the kit). No particular technical requirements are needed for this cable. 
 

   

Figure 15 – Pictures of the Ethernet cables provided in the StAnD Meteor Camera Kit. From left to right: the 2 
m CAT5e cable to connect the mini-PC to the switch (E1), the 5 m CAT6 fireproof cable to connect the all-sky 
camera to the network switch (E2), and the waterproof Ethernet RJ4 coupler to join the Ethernet cables to 
the all-sky camera (E3). 
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F. Packaging 

The whole kit is delivered by mail in a cardboard box with a StAnD branded sleeve (Figure 
16), with internal bubble wrap padding to prevent damage to the hardware during shipping. 
 

  

Figure 16 – The cardboard box used to deliver the StAnD Meteor Camera Kit by mail. Credits: N-3 srl - link 

3. Installation Guide 
 
This chapter covers the installation of the StAnD Meteor Camera Kit. The process can be 
subdivided into four main steps: 

1.​ Verification of the technical requirements; 

2.​ Assembly and installation of the all-sky camera mounting system (B); 

3.​ Installation of the all-sky camera (A) and connection to the room where the control 
mini-PC and network switch will be located (and, if necessary, installation of the 
electrical junction box); 

4.​ Installation of the control mini-PC (C) and network switch (D) and connection to the 
Internet network; 

5.​ First boot of the Meteor Camera Kit. 

3.1. Technical Requirements 

The following technical requirements have to be taken into account when identifying the 
location where to install the StAnD Meteor Camera Kit. 

3.1.1. Camera Positioning 

The all-sky camera should be installed on the roof of a building, preferably without 
prominent obstacles in its FoV (i.e. down until the visible horizon). Therefore, the building 
should be the tallest in its proximity.  
The last 10° above the horizon are not very important, usually because of light pollution that 
does not allow to detect stars (and even meteors if not too bright) anyway in this region. 
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Small obstacles (such as chimneys, antennas, flags etc..) close to the camera are not a deal 
breaker (a workaround is possible via software by masking them) but should be avoided. 

3.1.2. Light Pollution 

The StAnD Meteor Camera Kit can work properly even in light-polluted sites near large and 
medium-sized cities. This is because the targets of observation are bright objects (fireballs 
and bolides).  

To check the quality of the sky in your installation site, please refer to the Light Pollution 
Map - World Atlas 2015. For optimal observations, one should avoid installing the kit in 
areas in class 8-9 of the Bortle Dark Sky Scale, identified with the colors white to light violet 
on the World Atlas 2015. You can check this value by left-clicking on your position in the web 
map (see Figure 17). 
 

 
Figure 17 – Checking the classification of the sky quality according to the Bortle Dark Sky Scale on World Atlas 
2015 for the Astrophysical Observatory of Torino, on the hills East of Torino in the municipality of Pino 
Torinese. The site is in class 6 (bright suburban area), with a naked eye limiting magnitude between 5 and 5.5 
mag. These conditions are enough to ensure that the StAnD Meteor Camera Kit can work properly. Sites in 
the class 8-9 should be avoided. Credits: Light Pollution Map, World Atlas 2015 - link 
 
Of course, installation sites with lower light pollution are preferable. More importantly, you 
should check that there are no direct light sources (light poles, signs...) pointing toward the 
camera or that can produce diffuse light in its vicinity (~50 m from the camera) 

3.1.3. Camera Mounting 

The mounting system of the all-sky camera can be adapted to an installation on a flat surface 
(e.g. on a rooftop terrace), an inclined surface (e.g. on the roof), or on a pole (see Section 
3.2). The mounting on a pole must be avoided if there are other viable solutions. In this 
case, the camera will be more subject to vibrations due to wind.  
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The camera should be leveled (parallel to the ground), and the mounting should be as stable 
as possible (for both hardware integrity and stability of the calibration). 

3.1.4. Mini-PC and Network Switch Positioning 

The mini-PC and network switch must be installed inside a building (protected from the 
weather). The Ethernet cable connecting the all-sky camera and switch (E2) can be a 
maximum of 20 meters long (otherwise the connection delay between the camera and PC is 
too large), and the one provided in the kit is 5 m long.  

Therefore, another Ethernet cable of maximum length of 15 m can be added, using the 
junction box and the RJ4 couple provided in the kit (Figure 10, B6 and B7). 

3.1.5. Internet Connection and Power Supply 

There must be an Internet connection and at least two power sockets available in the room 
where the mini-PC and network switch are installed. The electric grid should guarantee the 
continuity of the power supply. If either the mini-PC or the network switch is disconnected, 
the kit will stop working.  

The network switch must be connected to the Internet via a stable connection; it doesn't 
have to be particularly fast, but stability is more important to ensure a constant connection 
to the central servers.The Internet connection has to be delivered by an Ethernet cable to 
the network switch. If this is not possible, you can use an Ethernet dongle with a WiFi 
antenna (WiFi/Ethernet bridge - example). On the network you are using to provide an 
internet connection to the switch, a DHCP server (Dynamic Host Configuration Protocol) 
must be available to issue the IP address to the mini-PC and the all-sky camera. 

3.1.6. Tools Required for the Installation 

●​ one Phillips screwdriver; 

●​ a 7 mm wrench to assemble the all-sky camera mounting system; 

●​ 4 to 8 wall plugs to install the all-sky camera mounting system; 

●​ a standard Ethernet cable to connect the network switch to the wired Internet 
connection of the building. 

3.2. Installation of the Mounting System of the All-sky Camera 

3.2.1. Assembly 

The mounting system for the all-sky camera (B) can be assembled in several configurations, 
depending on the features of the installation site: 

a)​ Installation on level ground is the most preferable option, if a flat and leveled surface 
is available on the rooftop of your building; 

b)​ When installing the mounting system on a wall, you should make sure that said wall 
will not obstruct the FoV of the camera; 

c)​ When installing the mounting system on an inclined surface, pay particular attention 
to level the system during installation (See Section 3.2.2). 
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Figure 18 – The assembly options for the mounting system of the all-sky camera provided in the StAnD 
Meteor Camera Kit. From left to right: on level ground (e.g. terrace), on a wall (top of the side wall of the 
building), and on an inclined plane (e.g. roof). Credits: FRIPON - link 
 

 

Step 1 - After having identified the suitable configuration, assemble the mounting system as 
shown in Figure 18. Mount the two side panels (B2) on the main body of the system (B1) in 
the desired position. Use four M4 bolts, nuts and rings (B4a) per side panel, tightening them 
with the 7 mm wrench. 

 
 

The mounting system can be also installed on a pole, as shown in Figure 19. Do not choose a 
long mounting pole. The longer it is, the worse it will be subject to oscillations due to wind 
and vibrations, which can disrupt the measurements and damage the hardware inside the 
camera. For pole mounting, follow steps 1a and 2a. 

 

    

Figure 19 – A scheme of the pole mounting system for the all-sky camera provided in the StAnD Meteor 
Camera Kit (left) and a picture of the system correctly mounted (right). Credits: FRIPON - link 
 

 

Step 1a - If necessary, attach the pole mounting plate (B3) to the mounting system. Use M5 
bolts, nuts and rings (B4b) to attach B3 to the bottom of the side panels (B2). In this case, 
the mounting system has to be assembled in the same way as for wall mounting (b). Then, 
mount the two rivets (B5) on the pole and fix them to B3, as shown in Figure 19. Use the 7 
mm wrench to tighten every bolt. 
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3.2.2. Installation of the Mounting System 

At the time of installation, check the following (see also Section 3.1): 

●​ The upper side of the camera mounting system must be horizontal. Check this with a 
spirit level; 

●​ The camera mounting system must be installed so that the horizon is as clear as 
possible; 

●​ The camera mounting system must be firmly secured and should not move even in 
case of strong winds; 

●​ Avoid sources of turbulence and noise (e.g. flags, chimneys, antennas) as much as 
possible; 

●​ Avoid direct urban lighting, which may come from unshielded lamps and ball lights, 
because of the risk of reflections on the objective lens; 

●​ If needed, the junction box must be installed in a place reachable with the 5 m 
Ethernet cable that attaches to the all-sky camera. 

 

Step 2 - Fix the assembled mounting system to the floor (Figure 18a), to the wall (Figure 
18b), or to the roof (Figure 18c). Use 4 - 8 wall plugs (2 - 4 per side) to fix the two side panels 
(B2). The holes on B2 are suitable for M5 screws. Use the Phillips screwdriver to tighten the 
screws. 

 

 

Step 2a - For pole mounting (Figure 19), fix the two side panels (B2) to the pole mounting 
plate (B3) with 4 - 8 M5 bolts (2 - 4 per side), nuts and rings (B4b). Use the 7 mm wrench to 
tighten the bolts. 

 

3.3. Installation of the All-sky Camera 

During the installation of the all-sky camera (A), pay very close attention not to scratch the 
camera dome. Remove the protective film as the very last step of the process, after the 
installation of the camera has been completed. The protective case is hermetically sealed 
with desiccant to prevent the formation of condensation inside of it. Therefore, the camera 
module must not be opened. 

At this stage, the aim is to install the camera on the camera support and to bring the 
Ethernet cable where the control mini-PC (C) and network switch (D) will be located. It is 
therefore a matter of completing the installation outdoors, while the next steps will be 
completely indoors.  

The camera support and the protective case have a dozen holes to allow the camera to be 
oriented to the North (within approximately 15°). Before the installation of the camera, 
check which direction is North in order to position the camera accordingly (see Figure 20). 
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Figure 20 – A picture showing how to correctly orient the all-sky camera of the 
StAnD Meteor Camera Kit to the North. The camera protective case has two bolts 
vertically arranged showing outwards (marked with the red line on the picture), 
with which the camera module is fixed to the inside of the case itself. Due to the 
internal arrangement of the components, the bottom portion of the CMOS is 
always facing this direction. Therefore, if one aligns such direction towards the 
North, an approximate reference frame can be defined a priori, and all cameras of 
the network can have the same approximate orientation. 
 
 

 

Step 3 - After having identified the North direction and the closest orientation of the camera 
to match this direction (See Figure 20), secure the all-sky camera module (A) to its support 
of the mounting system (main body, B1) with at least three M4 bolts, nuts and rings (B4a). 
Depending on the installation, it may be easier to remove the camera support to secure the 
camera to it and then reposition it afterward. The short Ethernet cable attached to the 
camera module has to go through the central hole of B1. 

 

Finally, the Ethernet connection from the camera module must be delivered inside the 
building, to the room in which the mini-PC and network switch will be installed. 

 

Step 4 - After having secured the camera module to its support, install the waterproof 
Ethernet RJ4 coupler (E3), one side to the short Ethernet cable coming from the camera 
module, to join with the 5 m Cat6 Ethernet cable (E2, see Figure 15). Then, secure the 
Ethernet cable to the pole, floor, or roof (depending on your installation configuration) 
according to the safety requirements of your building. The cable must reach the room in 
which the mini-PC and network switch will be installed. 

 

3.3.1. Installation of the Junction Box 

It may happen that the 5 m Ethernet cable (E2) provided is not long enough to reach the 
room in which the mini-PC and network switch will be installed. Then, there are two options 
to solve this problem. 

The first option is to replace the provided Ethernet cable with another one that is long 
enough to reach the said room. In doing so, make sure that the new cable fulfills the 
requirements (Cat6, suitable for outdoor installation, LZSH fireproof). It can have a 
maximum length of 20 m. 

Otherwise, a junction box (B6) is provided and can be mounted outdoors to extend the 
Ethernet cable provided in the kit to a maximum additional length of 15 m. The junction box 
serves to protect the junction between the two Ethernet cables by the female-to-female 
Ethernet RJ45 coupler (B7).  

The junction box has to be installed in a place reachable with the 5 m Ethernet cable 
provided in the kit. It should preferably be vertically fixed (on a wall). At least two screws are 
required on the inside of the junction box in order to fasten it to the wall. In order to prevent 
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rainwater infiltration, the junction box must be placed so that the holes through which the 
cables will pass face downwards (see Figure 21). All holes (both for fixing the junction box to 
the wall and for passing the cables) are sealed and must be pierced with scissors or a 
screwdriver before or during the installation. 
 

  

Figure 21 – Pictures of a correct installation of the junction box (B6) provided in the StAnD Meteor Camera Kit 
to extend the 5 m Ethernet cable with a second one. The junction box has to be installed vertically and the 
cables are to be inserted from the bottom holes, to avoid water infiltration. Credits: FRIPON - link 

 

 

Step 4a - If needed, install the junction box (B6) in a vertical configuration (e.g. on a wall) 
and in a place reachable within 5 m from the camera module. Remove the top panel (by 
unscrewing the 4 screws at the corners) and use at least two wall screws with plugs (not 
provided) to secure the box to the wall. After having pierced the two bottom holes of the 
junction box, let the two Ethernet cables (E2 and the extension cable) join into the junction 
box through the female-to-female Ethernet RJ45 coupler (B7) as shown in Figure 21. 

 

3.4. Installation of the Mini-PC and Network Switch 

Provided that the Ethernet cable from the camera module now reaches the room where the 
rest of the hardware of the Meteor Camera Kit will be located, it is now necessary to install 
the control mini-PC (C) and the network switch (D). Both these components are almost 
self-installing. The two main steps are the connection of both components to the power 
supply and the Ethernet connection through the network switch (see Figure 22). 

 

Step 5 - Connect the control mini-PC (C) and the network switch (D) to the power supply 
through their respective power adapter (C1 and D1, be careful not to mix them). Both plugs 
of the power adapters have to be inserted into the respective power input (see Figure 12 and 
14). The power LEDs for both devices will start blinking. If the power LED does not blink on 
the mini-PC after few seconds, press the power button. The network switch does not have a 
power button and it always turns on when plugged into the power socket). 
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Step 6 - Three Ethernet cables have to be connected to the network switch. The ports order 
is not relevant but, referring to Figure 22: 

●​ port 1 - Ethernet cable coming from the Ethernet wall plug (delivering the Internet 
connection of the building); 

●​ port 3 - Ethernet cable (E1) connecting the mini-PC to the network switch; 

●​ port 5 - Ethernet cable (E2) coming from the camera module installed outside. 

If a port is plugged in and the communication via the Ethernet cable is fine, the 
corresponding Ethernet LED (see Figure 14) will be turned on with a green (the port is 
running at 1000 Mbps) or orange/amber (10 or 100 Mbps) light, and blinking if transferring 
data. LEDs 3 and 5 should always be green while LED 1 may be orange if the Internet 
connection of the building is slower. This is not an issue. However, if LEDs 3 and/or 5 are 
orange, there might be some issues with the Ethernet cable installation. If some LEDs are not 
turning on, try to reconnect the cable and switch off/on the corresponding device. 

Finally, to check if the camera module is correctly powered via PoE, press the “Mode” button 
on the front of the network switch for about 1 second (see Figure 14). LEDs 1 and 3 should 
be turning off, and only LED 5 should remain on with a green light. This indicated that the 
power supply to the camera module is ok and stable. To go back to the previous LED 
configuration, press the “Mode” button again. 

 

 

    
Figure 22 – Desk installation of the StAnD Meteor Camera Kit (top panel), picturing that the camera module is 
installed outside, and with connection specifics (bottom panels). For this installation, the Ethernet cables are 
plugged into the network switch as follows (bottom right panel). The Internet network is plugged in on port 
1, the Ethernet cable from the mini-PC on port 3, and from the camera module on port 5. LEDs 1, 3 and 5 of 
the network switch are correctly lit up (bottom centre panel) and, when pressing the “Mode” button, only 
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LED 5 is on (bottom centre panel), all with green light. An orange/amber light might indicate a slower 
connection. 

3.5. First Boot of the StAnD Meteor Camera Kit 

If everything was installed correctly, the StAnD Meteor Camera Kit is already working and 
nothing else needs to be done with the hardware components.  

The final crucial point is to check the Internet connectivity of the kit, ensuring that it is 
correctly communicating with the central PRISMA servers. To do so, it is best to get in touch 
with your StAnD contact point. For more details about how to connect to the StAnD Meteor 
Camera Kit locally and from remote, please refer to Chapter 4.  

All components are configured to automatically switch back on if there is a power shortage, 
or simply if you plug them off the grid to transfer them somewhere else. However, it is best 
to always check the status of the LEDs after performing these operations and, if needed, 
force the reboot of the mini-PC by pressing the power button. To have further details about 
the maintenance of the kit, please refer to Section 4.4. 

From the point of view of the software, some intervention might be needed to complete the 
installation after the first boot. 

 

Step 7 - To ensure the correct connectivity and operativity of the StAnD Meteor Camera Kit, 
you should get in touch with your IT department (i.e., the person in charge of managing the 
Internet network of your building) and ask to open the following ports of the firewall: 

●​ port 1194 / UDP (OpenVPN protocol), used for the VPN (Virtual Private Network) 
connection to the central server of PRISMA; 

●​ port 80 / TCP (HTTP protocol), used to access the StAnD Meteor Camera Kit through 
its web browser interface; 

●​ port 443 / TCP (HTTPS protocol), used to deliver the updates to the kit. 

Depending on the time you received the kit, some software updates might be required to 
ensure its full functionality. Get in touch with your StAnD contact point to know more and 
schedule the intervention, if needed. 

 

4. User Guide 
 
This chapter aims to discuss how to access the StAnD Meteor Camera Kit on your local 
network and from remote, how to operate the kit through the provided browser 
user-friendly interface, how to access the data recorded by the kit and of the whole StAnD 
network, and how to maintain the hardware and software to ensure the best preservation 
and operativity of the kit through time. 

Within the PRISMA and StAnD network, each kit (i.e., each station or node of the network) is 
uniquely identified by a station code. An example of such a code is “ITPI01”, for which: 

●​ IT stands for the country (e.g. Italy); 

●​ PI stands for the region (e.g. Piemonte); 
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●​ 01 is a progressive numbering of the stations in that region. 

Alongside the code, each node is also identified by a station name, usually referring to the 
city or village where the station is located. For example, the PRISMA station ITPI01 is also 
called “PinoTorinese”. 

4.1. How to Access the StAnD Meteor Camera Kit 

The StAnD Meteor Camera Kit can be accessed by connecting to the mini-PC, which is the 
“brain” of the whole system. Knowing the IP address of the Mini-PC, access can be made 
from another PC, laptop, or mobile device through any web browser via a user-friendly 
interface. There are two IP addresses from which the mini-PC can be reached in such a way: 

●​ The local IP address, i.e. the address of the mini-PC within the local network of the 
building, to which the mini-PC is connected through the Ethernet cable going through 
the switch from the Ethernet wall plug.  

●​ The VPN IP address of PRISMA, i.e. the address through which the PRISMA server 
reaches the mini-PC. This address never changes but is accessible only if you have 
access to the PRISMA VPN yourself. 

An IPv4 address is a 32-bit number (for example, 192.168.1.1) divided into four octets (192, 
168, 1 and 1). The first three octets refer to the “network class” (i.e., 192.168.1). Very 
roughly speaking, the devices plugged in the Ethernet ports in the same room (e.g. 
classroom) should all share the same network class. 

4.1.1. Finding the Local IP Address of the mini-PC 

Through the local IP address, one can reach the StAnD Meteor Camera Kit only from the local 
network, i.e. if the computer of the user is connected to the same network to which the 
mini-PC is connected. Be aware that this IP address can vary over time (with a period of a 
couple of hours to a few days) if the local network is managed through a DHCP server 
(dynamic IP), or it can be a fixed IP address (static IP). To understand whether the kit will 
have a dynamic or static IP address, it is best to ask the IT department or person for your 
building or institution.  

If the mini-PC is assigned with a static IP, you can ask directly to your IT department to 
provide you with this address once and for all. Within the network, they might be able to 
identify the machine by the station code assigned to your kit. If online, the mini-PC will 
always be reachable through that static IP address. 

In either case, to find out the local IP address of the mini-PC, one can perform the following 
steps: 

1)​ Plug your computer (e.g. a laptop) with an Ethernet cable directly to the network 
switch or in an Ethernet port in the same network class (usually in the same room, 
see above). You might not get access to the Internet this way; this is not a problem. 

2)​ Find out the IP address assigned to your computer. To do so, on Microsoft Windows 
OS v. 10/11, go to Settings > Network & Internet > Ethernet, scroll down to the 
bottom of the page and search for the entry Address IPv4. Otherwise, open Windows 
Terminal (or Windows Powershell), type ipconfig /all, press Enter and search for the 
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entry Ethernet Adapter Ethernet0 / IPv4 Address. If you have a Linux or Mac 
computer, open a Terminal window, type ifconfig, press Enter and search for eth0 / 
inet. Write down this address. Let us say that the IP address that you have found is: 
192.168.137.124 

3)​ Download Advanced IP Scanner from the official website (it might be available in 
your language as well). Install the program on your laptop by following the installer's 
instructions, and start the program (see Figure 23).  

 

Figure 23 – Starting window of the Advanced IP Scanner program with instructions on how to search for the 
IP address of the StAnD mini-PC installed on the local network. 

 
4)​ Enter in the textbox under the Scan button the first three octets of the IP address of 

your laptop, adding the full range for the last octet: 192.168.137.1-255, and press 
Scan. Wait about 1 minute to let the program do the network scan. 

5)​ Once the scan is complete, you will have the list of all the devices that are plugged 
into that network. If you plug directly into the StAnD network switch, you should find 
a few devices. Otherwise, you may find a lot of them. See Figure 24 for an example of 
such a list displayed on the program. 

6)​ Search for the entries that have a small arrow on the left side of the IP address. 
Those are the machines that you can access. Left-click on them. One of them should 
display the code of your StAnD node (e.g. ELAT01 in Figure 24). That is the IP address 
of the mini-PC in your local network. You can copy it by right-clicking on the 
corresponding line and selecting Copy > IP. 
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Figure 24 – The result of the network scan to search for the StAnD mini-PC installed on the local network with 
the Advanced IP Scanner program. To identify which IP address is of the mini-PC, look into all the entries with 
a small arrow on the left side of the IP and right-click on them. One of them should display the code of your 
StAnD node (e.g. ELAT01 in this figure). In this case, its IP address is 192.168.137.249. 

4.1.2. Connecting to the PRISMA VPN from Remote 

If you have access to the VPN of the PRISMA network, you can reach the mini-PC remotely 
from your laptop, provided that you have an Internet connection (which does not filter VPN 
services). The use of this service is limited to 1 / 2 accesses per StAnD node. Get in contact 
with your StAnD contact point to get more information about this service and to file a 
request. 

Once your request is approved, you will receive a VPN certificate (.ovpn file). Do not share 
your certificate with anyone. Then, follow the next steps: 

1)​ Install OpenVPN Connect client. You can download the installer from the official 
website. Install the program on your laptop by following the installer's instructions, 
and start the program. 

2)​ Launch OpenVPN Connect and select Upload File. Then, browse to the .ovpn file that 
you received and select it, then click Connect. The imported profile will be saved, and 
you will be connected to the VPN (see Figure 25). 

3)​ To disconnect from the VPN, click on the slider. The next time the client is launched, 
the imported profile will be there and you will just need to click on the slider again. 
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Figure 25 – The interface of the OpenVPN Connect client used to connect to the VPN of PRISMA, with the 
main steps for the first installation. Import the .ovpn file and click Connect. The imported profile will be 
saved and, the next time you will launch the client, you will just need to click on the slider to connect and 
disconnect from the VPN. 

 
If the VPN connection fails, it is most likely that the Internet connection that you are using 
filters external VPN services. Get in contact with the IT manager 
Once you are connected to the VPN, to know the IP address of your StAnD mini-PC, ask your 
StAnD contact point. This address will never change over time. 

4.1.3. Accessing the mini-PC from Local or Remote 

If you have access to the VPN of the PRISMA network, or you are connected to the local 
network on which the StAnD mini-PC is connected, open a web browser, type the IP address 
of the mini-PC into the address bar and press Enter. If the connection is successful, you will 
be presented with the login page of the StAnD Meteor Camera Kit (see Figure 26). 

If you do not know your login credentials yet, get in touch with your StAnD contact point. 
There are two levels of authentication: 

●​ Guest credentials: the user can access, visualize, and download the data acquired by 
the kit; 

●​ Admin credentials: the user has all the privileges of a guest user but can also 
configure and operate it (turn on and off, reboot, start, and stop acquisitions) and 
modify the login credentials of authorized users. 

You can select the language on the right upper corner of the page. Enter your credentials 
and press Log in. If nothing happens, you have probably entered the wrong credentials. 

Every web browser should work fine. However, the best performance is usually granted by 
the Mozilla Firefox web browser. 
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Figure 26 – The login page to access the StAnD Meteor Camera Kit from a web browser. 

4.2. Browser Interface Description 

Once logged in, the browser will show the StAnD Meteor Camera Kit homepage (see Figure 
27) which presents the main functionalities of the kit. The elements of the homepage are the 
following: 

●​ Statistics of number of detections in total, of last month and of today; 

●​ Map of the station position; 

●​ Last detected image; 

●​ Tables of station data and today’s detection; 

●​ Summary of node status (error log and VPN connection status); 

●​ Data usage (CPU, RAM and storage of the mini-PC); 

●​ Sidebar menu options: 

○​ Users (users management area) - available to admin only; 

○​ Containers status (execution of Freeture) - available only to admin; 

○​ Freeture configuration (update the configuration) - available to admin only ; 

○​ Maintenance (reboot option) - available to admin only; 

○​ Calibrations (calibrations data) - available to admin and guest; 

○​ Stacks (stacks data) - available to admin and guest; 

○​ Detections (meteors data) - available to admin and guest. 
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Figure 27 – The homepage of the web browser interface of the StAnD Meteor Camera Kit, illustrating the 
status of the operation of the kit. The sidebar menu options link to the other web pages of the interface. 
Only the last three are available to a guest user (to download the data), while they are all available to an 
admin user. 
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In the following sections, the functionality of the kit is detailed by illustrating the content of 
the web pages linked to the sidebar menu options. 

4.2.1. Users 

This page is available only if you login as admin. See Figure 28 for an example of it. 

It lets you modify the password of the users (guest and admin). To do so, select the user for 
whom you want to change the password. Press the Modify button that pops up near the 
Change password title, then enter and confirm the new password, and press Confirm. Wait 
for a confirmation message (in a green textbox) to pop up at the top right corner of the 
screen. Otherwise, select Cancel to undo the ongoing change.  

 
Figure 28 – The Users page of the web browser interface for the StAnD Meteor Camera Kit (only available if 
you login as admin). The green textbox is reported as an example of the confirmation message that the user 
should receive after a successful operation (e.g. changing an user’s password). 

4.2.2. Containers Status 

This page is available only if you login as admin. See Figure 29 for an example of it. 

It lets you monitor and modify the execution status of the Freeture container, which is the 
program that runs and controls the whole operativity of the kit (acquisition schedule, trigger 
for meteor detection, etc…). If can monitor the status of the container under the List 
section. The status can be: 

●​ Up - the Freeture container is running; 
●​ Exited - the Freeture container is paused (the data acquisition is stopped); 
●​ Restarting - the Freeture container is rebooting (recently restarted or rebooting to 

load a configuration change, see Section 4.2.3). 
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You can start, stop or restart the container through the three buttons available on the right 
side of the status column. After pressing the corresponding button, wait for a confirmation 
message (in a green textbox) to pop up at the top right corner of the screen. For example, 
you might want to stop the execution of the Freeture container if you plan to perform some 
maintenance on the camera installation without unplugging the whole kit. 

Under the section Freeture logs, the user can monitor the details of the last operations 
performed by the kit, and download the log by clicking the Download button.  
 

 

Figure 29 – The Containers status page of the web browser interface for the StAnD Meteor Camera Kit (only 
available if you login as admin).  

4.2.3. Freeture Configuration 

This page is available only if you login as admin. See Figure 30 for an example of it. 

It lets you modify the configuration parameters of the Freeture program executing on the kit 
through three sections. 

The first section is Load file and allows you to modify the whole configuration file, with the 
option Upload new Freeture configuration file, and to upload a new mask file, with the 
option Load new mask. The first options should be used for debug purposes only and by 
skilled users (it requires to manually modify the field on the config file but may crash 
Freeture if not configured correctly). On the other hand, the second option is used to upload 
for the first time or modify the mask used by Freeture to filter false positives at the horizon 
of the all-sky camera (see Section 4.3.1). For both options, select a new file with the 
dedicated button, press the Load button on the right side of the file textbox and wait for a 
confirmation message (in a green textbox) to pop up at the top right corner of the screen.  
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Figure 30 – The Freeture configuration page of the web browser interface for the StAnD Meteor Camera Kit 
(only available if you login as admin).  
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In the second section, Automatic configuration, you can modify the most important 
parameters of the kit: 

●​ Station name and code: please do not modify these entries by yourself. If you think 
they are wrong, get in touch with your StAnD contact point first; 

●​ Observer: the name of the person in charge for the kit; 
●​ Altitude: the altitude from the sea level of the all-sky camera installation position, 

measured in metres; 
●​ Longitude: the geographic longitude of the all-sky camera installation position, 

measured in decimal degrees (E), with at least 4 - 5 decimal digits; 
●​ Latitude: the geographic latitude of the all-sky camera installation position, measured 

in decimal degrees (N), with at least 4 - 5 decimal digits; 

To modify one or more parameters, click the Modify button and edit the corresponding 
fields. Once you made all the changes, press Save and wait for a confirmation message (in a 
green textbox) to pop up at the top right corner of the screen.  

At the first installation, check the geographical coordinates with a GPS (the typical precision 
of a smartphone should be ok, otherwise check the position on Google Maps). If you need 
to move your camera, get in touch with your StAnD contact point first, and then change the 
coordinates on this page. 

The last section is Manual configuration and let you modify all the parameters enclosed in 
the configuration file of Freeture. The table can show 10 - 100 elements at once and gives an 
overview of the parameters, their corresponding values and a short description for each 
parameter. When first delivered, the camera will be already configured for its normal 
working conditions. Every modification of these parameters (apart from the ones listed in 
the Automatic configuration section) may disrupt the working flow of the camera, and the 
user takes responsibility for it when performing such modifications. 

4.2.4. Maintenance 

This page is available only if you login as admin. It lets you reboot the whole system by 
clicking the (only) red button Start the reboot. You will need to login again into the browser 
interface after the reboot is complete. Be aware that a reboot might change the local IP 
address if it is managed as dynamic. 

4.2.5. Calibrations 

This page is available to both admin and guest. See Figure 31 for an example of it. 

It lets you preview and download the calibration data (also called captures), which are 
images taken with the camera exposed for 5 seconds every 10 minutes during the day and 
night. Captures are acquired because the exposure time of the meteor videos (detections, 
see Section 4.2.7) is not enough to image stars, which are needed to perform the 
astrometric and photometric calibration of the camera.  

The first section, List, of the page displays two interactive tables to let you browse through 
the calibration data. The first table displays the last 10 days of acquisition (you can scroll 
back in time with the page Back / Next buttons) and the number of captures acquired during 
each day. A regularly functioning camera should acquire about 144 captures per day. 
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Figure 31 – The Calibrations page of the web browser interface for the StAnD Meteor Camera Kit (available to 
both admin and guest users).  
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By clicking on one entry of the first table, you select that particular day and display in the 
second table, on the right side, all the captures acquired during that day. Each entry reports 
the name of the image (in .fit format), the time of acquisition, and two buttons to preview 
and download the image. 

The preview must be enabled beforehand with the dedicated slider on top of the table. You 
can download the preview (.png format) by right-clicking on the image on your browser and 
selecting the Save image option. Since the previews are generated on request and make use 
of some computational power of the mini-PC to be produced, it is strongly recommended to 
not generate previews during night-time. The preview generation can be disabled by the 
admin (see Section 4.3). 

The second section of this page is Last calibration and displays the preview of the last 
capture acquired by the camera. 

Captures are preserved on the mini-PC for about two months. After this time, they are 
erased to free disk space for the new acquisitions. If the station is correctly online, captures 
are continuously synced to the PRISMA servers, on which they are stored and processed. 

4.2.6. Stacks 

This page is available to both admin and guest. See Figure 32 for an example of it. 

It lets you preview and download the stack data, which are data generated by stacking (i.e. 
summing) the images acquired by the meteor detection algorithm (30 fps, see Section 4.2.7) 
in 1 minute. Therefore, each stack image is the sum of 1800 frames acquired at 30 fps.  

The layout of this page is the same as the one of the captures data (see Section 4.2.5). 
 

 

Figure 32 – The Stack page of the web browser interface for the StAnD Meteor Camera Kit (available to both 
admin and guest users).  
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You can download the preview (.png format) by right-clicking on the image on your browser 
and selecting the Save image option. Since the previews are generated on request and make 
use of some computational power of the mini-PC to be produced, it is strongly 
recommended to not generate previews during night-time. The preview generation can be 
disabled by the admin (see Section 4.3). 

Stack images are saved to have live-time feedback of what is happening within the FoV of the 
camera, but are not included in the scientific processing. Therefore, they are not synced to 
the PRISMA servers. Stacks are preserved on the mini-PC for about two months and erased 
afterward. 

4.2.7. Detections 

This page is available to both admin and guest. See Figure 33 for an example of it. 

It lets you preview and download the detection (meteor) data, which are videos of meteors 
captured by the Freeture software. As already mentioned, the camera is continuously 
operated at 30 fps to check for the passage of meteors in its FoV. This is done by an 
automatic trigger software operating within Freeture, which checks (during night-time) for 
the presence of fast-moving bright sources in subsequent images on the 30 fps video 
stream, which may be meteors or fireballs. In such a case, Freeture saves the portion of the 
video over which the meteor was detected.  

The layout of this page is similar to the one of calibration and stack data. The first section, 
List, lets you browse the list of detections during each day. For each detection, you can 
preview and download the following: 

●​ Preview: an integrated image of the video, over which the meteor track should be 
visible (see Figure 34); 

●​ DirMap: an image with dots indicating the estimated and approximated position of 
the meteor within each frame during the video, computed by the trigger algorithm 
(see Figure 34); 

●​ GeMap: a black-white image indicating the region in the frame where the meteor was 
detected by the trigger algorithm (see Figure 34); 

●​ Video: a video of the meteor generated by the browser interface in .mkv format; 

●​ Zip: the data of the meteor detection acquired by Freeture in .fit format. 

You can download the preview (.png format), DirMap and GeMap (.bmp format) by 
right-clicking on the image on your browser and selecting the Save image option. The 
preview generation can be disabled by the admin. Also, the download of video and zip files 
must be activated by the admin (see Section 4.3). Since the previews and videos are 
generated on request and make use of some computational power of the mini-PC to be 
produced, it is strongly recommended to not generate previews and download videos and 
zip files during night-time.   

Being an automatic software, detections may contain false positives, that is, a detection may 
be due to other natural or artificial events occurring in the FoV of the camera. For example, 
the lights of a car passing by may trigger a detection on the horizon of the camera in a 
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particularly dark observational site, if not filtered by the application of a mask (see Section 
4.2.3 and 4.3.1). 

Detections are preserved on the mini-PC for about two months. After this time, they are 
erased to free disk space for the new acquisitions. If the station is correctly online, detections 
are continuously synced to the PRISMA servers, on which they are stored and processed.  

The second section of this page is Last detection and displays the preview of the last 
detection captured by the camera. On the right side, you can also see a graph of the number 
of detections made during the last days. 
 

 

Figure 33 – The Detections page of the web browser interface for the StAnD Meteor Camera Kit (available to 
both admin and guest users).  
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Figure 34 – An example of preview images for a detection made by the FRCA20 - Nice camera of the StAnD 
network on 13th January 2025 at 22:20:12 UT. The top panel displays the meteor track from an integrated 
image of the video, while the bottom panels display the DirMap (left) and GeMap (right) bitmaps, on which 
one can observe the approximated position on the frame of the meteor detected by the trigger algorithm. 
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4.3. Maintenance of the Kit 

4.3.1. Detection Mask 

After the first boot of the StAnD Meteor Camera Kit, once you verified that the kit is 
connected correctly to the Internet (see Section 3.5), you will need to update the detection 
mask to minimize the number of false positives detected by the Freeture trigger software 
(see Section 4.2.3 and 4.2.7). Such detections are due to various artificial sources and 
typically happen at the horizon of the FoV, for example due to flickering lights or cars passing 
by during night-time.  

An increased number of false positives in the detection dataset might cause the HDD of the 
mini-PC to fill up faster than two months, resulting in a lower performance of the kit and in 
a shorter timespan before data are erased from the mini-PC locally. 

Depending on the configuration parameters (see Section 4.2.3), it may also happen that 
Freeture will not start correctly without a mask being uploaded. In this case, if you would 
like to start the operation of the kit regardless, login into the browser interface, go to 
Freeture configuration and change the parametre ACQ_MASK_ENABLED to false (under the 
Manual configuration section of the page). Remember to set this parametre back to true 
after having uploaded the mask. 

The detection mask has to be an 8-bit black-white .bmp image with the same resolution of 
the frame acquired by the camera. In this image, the black portion will mark the region 
where triggers should be excluded by Freeture, and the white portion will be the region 
where the software will look for triggers. 

The detection mask needs to be uploaded after the first installation of the kit, if you move 
the camera installation position or if you modify the orientation of the camera. To do so: 

●​ you can ask to your StAnD contact point to do it for you; 

●​ If you wish to do it yourself, you can download a night-time capture preview from 
the browser interface and use it to create your own mask. You can modify it by using 
any image manipulation program, such as GIMP. You can follow these steps: 

1)​ After having installed this software, launch it and select FIle > Open from the 
menu bar, and select the downloaded .png capture preview;  

2)​ You can use the Free Selection (Lasso) tool to highlight the area to be masked 
(i.e. the border of the horizon to be masked, see Figure 35);  

3)​ Once you are done, press Enter and sharpen the border of the selection 
(Select > Sharpen from the menu bar) and fill it with white color with the 
Bucket Fill tool;  

4)​ Then, invert the selection (Select > Invert from the menu bar) and fill it with 
black color with the Bucket Fill tool;  

5)​ Go to Image > Mode from the menu bar and select Grayscale mode, then 
again Image > Precision and select Integer 8-bit; 

6)​ To export the image, go to File > Export as to save the image, select the .bmp 
format and save it on your computer;  
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7)​ Finally, you can upload it through the browser interface (as admin) and, if 
needed, reset the Freeture parameter ACQ_MASK_ENABLED to true in the 
Manual configuration of the Freeture configuration page (see Section 4.2.3). 

 

    

Figure 35 – An example of the detection mask for the StAnD camera FRCA20 - Nice. The left panel highlights 
the border that was selected on GIMP to define the masked region, and the right panel shows the final result 
(where the white portion of the image marks the region where trigger are possible, and the black part the 
excluded region) . One may notice the the upper-right horizon is on the image is masked with a thicker 
margin, because there is an intense light from a street lamp. Also, the lights from cars passing in that 
direction by were found to be triggering false positives during night-time. 
 

After having changed the detection mask, you can monitor if the camera is frequently 
detecting false positives during night-time from the browser interface. If so, you can adjust 
the mask, for example raising the border over the horizon to mask a bit more pixels and 
exclude the region that is causing such false positives. 

4.3.2. Software Monitoring 

To ensure the best operativity status of the StAnD Meteor Camera Kit, you should 
periodically check the functionality of the software by logging on the browser interface (as 
admin) and check the status of the following pages (at least every 10 - 15 days if possible): 

●​ On the homepage, check if any errors are reported under the Node status section. If 
you see some errors, report the issue to your StAnD contact point.  

●​ On the Containers status page, check if the Freeture container is up and running. If 
not, check for errors in the log and try to restart the container. If this attempt fails, 
report the issue to your StAnD contact point.  

●​ On the Calibrations and Stack pages, check if data are being acquired regularly 
everyday. You should see about 144 captures per day and about 1440 stacks per day. 
If you see lower numbers, report the issue to your StAnD contact point.  

 

41 
This project has been funded with support from the European Commission. This publication reflects the 
views only of the author, and the Commission cannot be held responsible for any use which may be made 
of the information contained therein. Project No. KA220-SCH-F3BE36BB. 



 
 

4.3.3. Hardware Monitoring 

To ensure the best operativity status of the StAnD Meteor Camera Kit, you should 
periodically check the status of the hardware of the kit (at least each 10 - 15 days if possible): 

●​ Check the status of the protective plastic dome of the all-sky camera. Water droplets 
are not a problem, especially during summer time. If you see some dirt piling up on 
the dome, clean it very gently with a wet microfiber cloth, trying not to alter the 
orientation of the camera. 

●​ Check the status of the Ethernet cables (and junction box if installed) that are 
exposed to atmospheric agents. A degraded Ethernet cable may not be able to 
withstand the data traffic, especially for the one connecting the all-sky camera 
module to the mini-PC. 

●​ Check the status of the mini-PC and network switch. They should be powered on, 
with all the cables correctly plugged in, and showing the correct lights on their front 
(see Section 3.4). If you know that the power went down in the building, check if the 
mini-PC is back on, otherwise power it on by pressing the power button on its front 
(see Figure 12). 

5. Data Analysis Tool 
 
Forthcoming (June 2025) 
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